[bookmark: h.icneug3ebnpf]Making Impress A UX Princess	Comment by Christoph Noack: Looking at the title, is this document meant to discuss further improvements?

However, thanks for the great overview ...	Comment by Yousuf Philips: I titled it that as we had been joking about it in the irc and the title princess came up. ;D


This document is being prepared to address the user interface and experience problems currently affecting LibreOffice Impress.
Note: You are more than welcome to leave comments in the document, but if you do so, please login to google drive/docs, so that your comment will appear as written by you and not ‘Anonymous’. Or alternatively, leave your name in the comments you write. :D
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[bookmark: h.npfc3emidtsx]Template Selection (tdf#89664)
In the OpenOffice.org days, when impress was launched, a wizard was presented to users to allow them to either create a blank presentation or select from a variety of presentation templates and backgrounds, select the default slide transition, and type some basic information about the presentation that would be added automatically to the generated presentation.

[image: ]
Presentation Wizard from LibreOffice 3.3.0	Comment by Heiko Tietze: Brainstorming for additional features, e.g. after selecting empty presentation and next: 
* footer with date, slide number, title etc. 
* page format such as 4:3, 16:9
* dark/bright environment resp. background color	Comment by Yousuf Philips: Well the wizard approach isnt something we want to have as its wastes time, as a user just wants to select a template and thats it.	Comment by Heiko Tietze: No wizard: Check, and agreed. (However I'm confused what the doc is intended to be. Apparently to add/included more/better templates. Edit: With the new UX section it's clear.)	Comment by Yousuf Philips: First to explain how it was and the solution LibO took, which didnt make the UX better. Also the wizard is still in LibO but disabled by default in Tools > Options > Impress > General > New Document.

This wizard has been scrapped in LibreOffice, which results in a user opening Impress always to a blank presentation unless they first start at the Start Center and navigate to the Templates section or alternatively open File > Templates > Manage, which results in a new document being created with the selected template. Some users may navigate to the Master Pages sidebar tab to import a slide master from a template, but selecting an entry will only import the first slide master from a template.	Comment by Christoph Noack: There have been quite some discussions about this issue in the past. Looking at LibO in general, its behavior is a bit different to other productivity suites:
* Start LibO Module (e.g. Impress) -> New empty document
* Start LibO Main -> StartCenter (different to e.g. MS Office behavior

Offering that kind of module access led to following (unfortunate) workflow in the past: Start LibO Main > Presentation > Presentation Wizard > Create > Finally, an empty document :-)	Comment by Yousuf Philips: Yes i would go through the same workflow when i used to test use it as i hated seeing the wizard, so i would see the wizard and simply click the 'Create' button rather than read it. I normally do the same with the chart wizard. :D	Comment by Heiko Tietze: Don't understand this coming back from the next picture. Doesn't templates usually consists of two or more slides? And if so it has to be shown under "choose a theme".	Comment by Yousuf Philips: The text here is talking about libreoffice and not google docs

So to fix this issue, Impress must start with a dialog of template previews that a user can choose from. This is the norm with all presentation apps and sticking with this normal will reduce the learning curve for new users. Unlike in word processing and spreadsheet applications, users expect to have a selection of templates to choose from, so they can focus on entering in their content rather than worrying to also coming up with their own design.	Comment by Christoph Noack: To me, it rather comes back to an old question of how to distribute the functionality:
* (none)
* Start Center
* Impress (new document, on demand)
* Impress (new document, on startup)
* Impress (during editing)	Comment by Yousuf Philips: I'd say Impress (new document, on startup) and they can change the theme during editing if they like, which covers the on demand scenario.	Comment by Christoph Noack: Clarification needed: Just templates, or the (former) creation of an (empty) document structure via the Wizard?	Comment by Yousuf Philips: Yes just template and no wizard.	Comment by Christoph Noack: How can we validate this? Why might the expectation be different to other modules of LibreOffice?	Comment by Yousuf Philips: Presentations are expected to look good as they are presented on a projector, incomparison to word processor documents and spreadsheet where its not. So for users who dont know about good design, they are left at a disadvantage if no good default templates are provided.
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Template selection in Google Docs
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Template selection in WPS/Kingsoft Office
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Template selection in Calligra Stage
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Template selection in Powerpoint 2013
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Template selection in Presentations X7 (part of WordPerfect Office)


The template selection dialog that is created for LibreOffice should have the ability to	Comment by Christoph Noack: Does the proposed change also includes the removal / update of the other assistant?

See: https://help.libreoffice.org/Common/Presentation_Wizard

And: https://help.libreoffice.org/Common/Start_Center (Templates and Documents)	Comment by Yousuf Philips: The presentation wizard is disabled by default in LO, so if this dialog was created, then i'd assume it would replace it. In order to replace 'Templates and Documents', the dialog would need more functionality.
· select a template from the list
· set the selected template as the default template for the dialog
· disable the dialog from appearing when opening Impress
· load/import a template from an existing presentation or presentation template

Once a user selects a template from the list, he/she should also be able to easily switch to another template at any point (e.g. while working on the presentation or after reopening a saved presentation), so they can test how their presentation would appear on another template without having to redo it from scratch.	Comment by Christoph Noack: Here it might be helpful to think about consistency with / improvement for other "slide design" features (I currently lack a reasonable solution...)	Comment by Yousuf Philips: Didnt quite follow?



[bookmark: h.3pb2w0aoans9]Template Gallery
OpenOffice.org and LibreOffice has always shipped with a poor selection of default presentation templates, which is why that when the design team did a survey about Impress, the number one requested feature users asked for was a nicer selection of default templates. This issue was intended to be addressed by running a continous template competition starting in December 2014 for the 4.4 release, but unfortunately very few templates were submitted and the competition wasnt regularly announced to prompt users to continue to contribute. 

Presently we ship with 4 Impress templates with multiple master slides that were obtained through the competition and 10 old background templates that aren’t very nice and only have a single master slide. It would be good to have at least 20 good templates with master slides for title (Title Slide), content (Title, Content), section (Title Only or Centered Text) and possibly a final presentation slide. It would also be good to have a variety of templates from various categories - plain color, gradients, random graphic, and topic themed. Ideally these themes should work in both standard (4:3) and widescreen (16:9) views.

[image: ]
Template selection in iWork Keynote

If the community can not complete the needed selection of templates, then the TDF should put out a design tender for this. Possible designers to approach - 24slides.com, showeet.com

[bookmark: h.lbg8tx7i5p99][bookmark: id.eoc3jdsofq0j]Template Categories
· Simple/Color - Contains single color slides like black and white (seen in both google docs and keynote screenshots), linear or radial gradients (seen in both google docs and keynote screenshots), and simple general purpose, shape/pattern/graphic oriented design that doesn’t portray a particular topic (most of the ones found in google docs, presentations x7, powerpoint)
e.g. office.com, showeet.com - Blue Mosaic, Origami, Watercolor, Puzzle, Pixel
· Business - Professional looking and geared to be used by companies and organizations containing charts, diagrams, organizational charts, and flowcharts (e.g. slideshop.com business & diagrams & charts, showeet.com), but also busines related like trial & error (winner/success, loser/failer), challenges, competition, meeting, finance, stress, confidence, growth, proposal, timeline (e.g. slideshop.com meeting, growth, showeet.com success, climbing the ladder)
· Education - Themed around learning, whether it be about a particular subject (science, literature, etc), certificate/diplomas (e.g. slideshop.com, showeet.com, templateswise.com school bus, book, templatemonster.com, fppt.com)
· Themed - Templates geared toward a particular topic like religion/culture, fitness,  food/cooking, occasions (birthdays, weddings, newborns, memorial, christmas), nature/environment, architecture, art/music, health, transportation, travel, real estate
· Maps - Templates showing the map of the world, continent, region or country (e.g. slideshop.com, showeet.com)
· Shapes - (e.g. slideshop.com, showeet.com)


Stuff I had written in the Design PAD
+ Pulling templates from template site - gathering ideas (Jay)	Comment by Heiko Tietze: Would be nice to get a screenshot here.	Comment by Yousuf Philips: This is a list of templates that i thought were good enough that we could possibly bundle with LO
   http://templates.libreoffice.org/template-center?getCategories=Presentation&getCompatibility=any 
     found some nice recent impress templates on the template site that are likely worth considering
     http://templates.libreoffice.org/template-center/material-design-cyan 
         https://github.com/dairdev/LOF-Impress-Templates (i think skylightblue is simple and nice)
     http://templates.libreoffice.org/template-center/fresh-serious-1 
         this one is old but nicely designed and has master slides for title, 3 for content
     http://templates.libreoffice.org/template-center/vintage 
         another old one but nicely designed and has master slides for title, 3 for content
     http://templates.libreoffice.org/template-center/university-course-material-template (public domain)
         slightly old one and has master slides for title and 1 for content
 
 + Sources of template ideas
   * slideshop.com, showeet.com, tidyform.com
   * AOO templates - http://templates.services.openoffice.org/en/search?f[0]=field_template_application%3A30



[bookmark: h.na8z52oxjkeu]Cleaner Interface
The biggest complaint by users of Impress has always been of the design and clutter of the  interface and this is one of the reasons why Project Renaissance in 2009 decided to focus initially on improving it.

[image: ]
Slide from a March 2009 status update from the Project Renaissance team

Their efforts to improve Impress resulted in having hover access to slide features (start slide show, hide/show slide, duplicate slide) in the slide pane, as well as improved slide selection and management in the slide pane and slide sorter view (video). They also tackle easy access to add a new slide with a particular layout, as well as easy access to change and reset a slide’s layout (video).	Comment by Christoph Noack: To me, the most impressive / visible improvements were done in the prototype (e.g. zooming slide overview), see the video at: https://wiki.openoffice.org/wiki/Renaissance:Prototyping	Comment by Yousuf Philips: Yes i would assume the best stuff didnt land in OOo with all the backlash from the community. :D

The LibreOffice design team did an Impress survey in November/December 2014 asking users how they use impress and a large number of users complained about the cluttered UI. So during the 4.5/5.0 development cycle, the contextual toolbars were hidden in favour of having users utilise the properties tab of the sidebar for formatting options.

Additional work needs to be done to further reduce the clutter found in the interface, similar to
1. The view tabs - many users never switch to a different view but the view tabs take up a good chunk of space that could be used to show a larger slide. So either we have the tabs hidden by default with the ability to reactivate, or we move them into the slide pane - tdf#87672 (mockup)
2. The drawing toolbar - many users dont add shapes to their presentation, or more accurately add very few shapes, so it would be ideal to hide this toolbar by default, as we do in writer and calc, and add basic shape options to the standard toolbar and provide an easy means of activating the drawing toolbar - tdf#89540	Comment by Christoph Noack: The question is: don't they add shapes, don't they find the shapes useful, or is the feature unknown to them...	Comment by Yousuf Philips: If a user uses a good template, it will provide all the features needed and a user would simply just be added text, images, media and possibly charts.
3. Moving slide manipulation buttons into the bottom of the slide pane, which frees up space in the standard toolbar for basic shapes and alignment/arrangement buttons - tdf#89668 (mockup)
[image: New Impress.png]
Mockup of what the new interface would look like	Comment by Yousuf Philips: button to activate the drawing toolbar was forgotten out of mockup, but it should have appeared next to the basic shapes split button, like in writer. :D

[bookmark: h.qluyiy884h8g]Improving Functionality / Compatibility
· Shadow Blur - LibO has the ability to add a shadow behind text and shapes/objects and the ability to set its distance, transparency and color, but one of the most commonly set features of a shadow is its blur and this features isnt available. This feature is available in all competing apps (MSO, iWork, Calligra) and having this ability will also improve document compatibility - tdf#48722 / tdf#61543 / tdf#84387

[bookmark: h.zj5hbcz3rb0]Sidebar	Comment by Heiko Tietze: Looks like you are in the documentation business now, Jay ;-)	Comment by Yousuf Philips: Yep i'm trying to pull everything together for a clear vision of the needed improvements. :D
As the sidebar is the main focal point of usability in Impress, it requires the most amount of focus for improvements. For GSoC 2015, we have a student who is working on improving the sidebar across all the apps.
· [bookmark: h.kcfgkeqq4p2x]Properties Tab
· Add ‘Slide’ section - tdf#89466 (mockup) (work in progress)
· Add ‘Media Playback’ section - tdf#87794 (mockup)
· Add ‘Shadow’ section - tdf#87702 (mockup) (work in progress)
· Add ‘Interaction’ section - tdf#89667
· Addition of outline/bullet commands to ‘Paragraph’ section - tdf#87651
· [bookmark: h.ex9ys0tuod5m]Slide Transitions Tab
· Reorganizing the lower half - tdf#87862 (done)
· Group and sort slide transitions alphabetically - tdf#87613
· Separate slide transition sub-types into separate listbox - tdf#87621
· [bookmark: h.svlpm769wxt]Custom Animation Tab
· Move Effects List from dialog into sidebar - tdf#87813 (mockup)
· Show more details about an animation - tdf#87812
· Copy and paste animation style to another object - tdf#88938
· [bookmark: h.38hmrrigh3cj]Master Pages Tab
· With the ability to set the presentation template at the start and the easy ability to switch between templates, this tab would ideally be retired.
· [bookmark: h.s3pfzbjvggzd]Navigator Tab
· There are a number of enhancements that would primarily benefit Draw but would also benefit Impress for users who use the Navigator
· Unnamed shapes should be shown by default - tdf#90277
· Contains incorrectly naming, numbering and iconifying objects - tdf#90242
· Improve object management by allowing shapes to be hidden (rather than setting the object to ‘Object with no fill and no line’ style), locked (rather than Format > Object > Position and Size > Protect > Position), and changing their arrangement - tdf#90244

[bookmark: h.3xs15b1tvdy0]Menu Bar
· Reorganize the menu bar by including all commands in it and bringing together all the slide manipulation/management commands under a new menu bar entry called ‘Slide’. - tdf#91857 (mockup)
· Add new slide navigation (next slide, move slide up, etc) uno commands to the menu bar for shortcut discovery - tdf#91909
[bookmark: h.p8s6e0z038b1]Normal View
· Shortcut for inserting a slide - Powerpoint uses Ctrl+M but LO uses that for clearing direct formatting
· Textbox outline should always be visible if border is not set, not only when data hasn’t been entered into it, or alternatively show the outline when the textbox is hovered over
· A speaker notes area below the slide which can be resized and hidden would make Impress have a feature available in all presentation apps and not require a user to go into ‘Notes’ view, which has a huge notes area, in order to type in notes.
[bookmark: h.tayffuqmy9dg]Slide Master View
· Different background color for Master Slide view so a user can easily identify which view they are in. The color should be taken from the desktop environments theme colors, ideally a dark color on light theme and light color on dark theme - tdf#87905
· Slide Pane should be titled 'Master Slides' when in master view - tdf#87638
· Outline, Notes, and Slide Sorter view tabs are not part of slide master mode, so they should be disabled or hidden, while Master Notes should be visible - tdf#91827
[bookmark: h.4kqbo6b8tnfc]Slide Sorter View
· Ability to increase and decrease the number of slides per row with the ctrl + mouse wheel combination used for zooming in and out in other views
· It would be best that the sidebar was disabled in this view, similar to the slide pane



[bookmark: h.347xzzs9n75h]Research

[bookmark: h.xoxsz1y406v2]Popular Slide Transitions
· Powerpoint Online provides 2 slide transitions - Fade (Smoothly, Through Black), Push (From Bottom, From Left, From Right, From Top)
· Google Docs provides X slide transitions - Fade, Slide (From Right, From Left), Flip, Cube, Gallery	Comment by Yousuf Philips: 'Fade Through Black' in LibO	Comment by Yousuf Philips: 'Push Left' in LibO	Comment by Yousuf Philips: 'Push Right' in LibO	Comment by Yousuf Philips: 'Turn Around' in LibO	Comment by Yousuf Philips: 'Outside Turning Cube' in LibO	Comment by Yousuf Philips: no LibO equivalent
· User-Prompt.com’s Impress survey had users say these were their popular transitions
· Fade Smoothly, Fade Through Black
· Push, Box, Cover/Uncover, Cut Through Black
· Wipe, Dissolve, Rochade

[bookmark: h.wdz2wr5qcsos]Popular Custom Animations
· Powerpoint Online provides 3 custom animations - Appear (As One Object, As Paragraphs), Fade In (As One Object, As Paragraphs), Fly In (From Bottom, From Left, From Right, From Top | As One Object, As Paragraphs)
· Google Docs provides 7 custom animations - Appear, Disappear, Fade (In, Out), Fly In (From Left, From Right, From Bottom, From Top) Fly Out (From Left, From Right, From Bottom, From Top), Zoom (In, Out), Spin
· User-Prompt.com’s Impress survey had users say these were their popular animations
· Fade In/Out, Appear
· Fly In, Zoom, Wipe, Dissolve
· Boomerang, Swirl
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Research Wrap-Up — Summary

* Overall, what seems most problematic in Impress is

> Usability and the design of the user interface

> Compatibility to MS PowerPoint

> Lack of key features e.g. video/audio/animation

> Performance e.qg. slide transition, rendering quality
> Lack of professional and integrated templates
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